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Welcome to Timberline Digitizer
Timberline© Digitizer Standard from Timberline Software is intended to bring a full 
range of digitizer functionality to users of Estimating. As soon as you are familiar with 
the information in this booklet, you should be ready to begin using Digitizer. 

How to use this booklet

We know you are eager to start working as quickly as possible, and the goal of this 
booklet is to help you do just that. Depending on your level of experience, you may find 
the following sections of interest.

■ Some basic concepts — the concepts and philosophy behind Digitizer

■ The ABCs of digitizing — step-by-step instructions for the most commonly performed 
procedures

The discussion about using our extensive Help system should be of particular interest 
to all users.

■ Time-saving tips — helpful hints for using Digitizer

■ Go ahead … try it out — a last word of advice
Welcome to Timberline Digitizer 1



Help - always at your fingertips
Digitizer provides all 
the help you need right 
on your computer. In 
addition, our competent 
technical staff is ready 
to assist you.

■ The software includes 
a comprehensive Help 
system. It provides not 
only context-sensitive 
help about what you 
are doing, but also 
step- by-step instruc-
tions and “Show Me” 
demos. 

■ If you purchased the 
software, you auto-
matically receive 90 
days of free telephone 
support and other 
benefits.

■ You can also obtain 
information from our 
web page (www.tim-
berline.com) on the 
Internet.
2 Getting Started
Comprehensive help on your computer

Instead of bulky manuals that you never quite get around to 
reading, help files come with Digitizer. Our efficient Help 
system provides faster access to more information than most 
manuals. With a click of the mouse or a keystroke, you can 
easily get help for a command, a field, a window, or a procedure. 

Window level help 

Topic level help

Context-sensitive help

Video demonstrations

Instructions for using Help

Timberline licences

Telephone and e-mail support

Web site for Timberline Software

Software version information

Field level helpF1



Technical support

If you have questions or problems not covered by the Help system, you can communicate 
by telephone, FAX, or e-mail. The US support line is open from 7:00 a.m. to 5:00 p.m. 
Pacific time, Monday through Friday. Outside the US, contact your nearest distributor. 

When calling, have your customer number handy and be at your computer. 

■ If you are not on a service plan, you can call on a charge-per-call basis. Please be 
prepared to give the number of a major credit card when you call.

■ If you are using the trial software, please contact your local Solution Provider 
(authorized Timberline dealer).

For support in Call FAX E-mail

US/Canada 1-800-551-8307 503-439-5940 pesupport@timberline.com

Australia 1800 120 369
+503 439 5178

1503 439 5940 austrest@timberline.com

Asia-Pacific +503 439 5178 +503 439 5940 austrest@timberline.com

Other international areas +503 533 2181 +503 439 5940 pesupport@timberline.com
Welcome to Timberline Digitizer 3



4 Getting Start
First things first
The first thing you need to do is to set up the Timberline Estimating products on your 
computer. Timberline has automated the installation procedure, so the entire process 
takes only a few minutes. 

Check your product package

The product package includes everything you need to install and use Digitizer. In 
addition to this booklet, you will find the following: 

■ The Timberline Estimating CD-ROM, which includes the Digitizer software. Your 
Digitizer access code installs Digitizer and the help files that give step-by-step 
instructions for using the software.

■ A packing slip (with activation codes for each Timberline application).

■ An installation card for basic instructions on installing the Estimating products.

Install the software

For information about installing the Estimating products, refer to the installation card 
included in the product package. You can find more detailed installation instructions, 
as well as tips for setting up Timberline Estimating, in the Resource and Installation 
Guide located on the CD-ROM in the Documents folder. 

How to start Timberline Digitizer

After installing the software, you can open any Timberline application from the Start 
menu. 

1 If you did not restart your computer at the end of the installation, do so now. 

2 From the Start menu, open the Program group and then the Timberline Office group. 

3 From the Estimating group, choose Digitizer. 

Note: The typical method of starting Digitizer is directly from Timberline 
Estimating.
ed



Some basic concepts
If you are new to Digitizer, there are a few basic concepts you should understand before 
you begin using the product. The concepts are not difficult, and you may already be 
familiar with some of them. After reading this section, you will be ready to try the 
procedures in The ABCs of digitizing.
Some basic concepts 5



How to work with a digitizing device
Digitizing involves 
using a pointing device 
(stylus or puck) to 
transfer the dimen-
sions, lines, and shapes 
on the digitizer tablet to 
your computer. The 
lines and points you 
digitize appear in the 
graphics area of the 
Digitizer window. 

Among the things you 
can control in the digi-
tizer window are: 

■ toolbar position and 
shape

■ background color
■ kind of units
■ number of decimals 

shown
■ line color and style
■ count symbol
■ display of coordinates

After you attach a digi-
tizer and install the 
driver, you can use the 
pointing device as your 
mouse.
6 Getting Started
The Digitizer window

The graphics area, which corresponds to the digitizer tablet, 
occupies most of the main window. The menus, toolbar, and 
status information are located above and below the graphics 
area. 

Title bar
Menu bar
Toolbar

Graphics area

Totals bar
Status bar



What you see in the graphics area

Whenever you start Digitizer, the screen is set up to encompass as much of the digitizer 
tablet as possible. There is a direct correspondence between the top and bottom of the 
digitizer tablet and the top and bottom of the active area on the screen. You can easily 
resize and reposition the screen to include a work area anywhere on the digitizer tablet. 

How to deal with a large drawing

If you are working with large plans, it is more efficient to focus on one part of the drawing 
at a time. You simply define a work area on the drawing tablet by using the Zoom Window 
command in Digitizer. Defining a work area accomplishes two things:
■ It enlarges the digitized image on your screen.
■ It keeps the Digitizer menus within easy reach.

See page 16 for more about how to focus on a portion of the digitizer tablet. 

Active Area

Digitizer tablet

Inactive Area
Some basic concepts 7



How Digitizer works with Estimating
Digitizer is available 
from takeoff quantity 
and variable fields in 
Estimating. You can 
access the digitizer 
directly from the Esti-
mating spreadsheet or 
from windows used to 
enter variables.

As a productivity tool, 
Digitizer lets you:

■ make measurements 
on blueprints and 
transfer the measure-
ments directly into 
Estimating.

■ set the drawing scale 
used for calculating 
dimensions.

Once you choose a digi-
tizing mode, you may 
notice that the mouse 
and pointing device 
move the cursor at dif-
ferent speeds.
8 Getting Started
In Estimating, the estimate is represented by a spreadsheet that 
contains items brought in from the database. Digitizer can be 
used to measure and calculate the takeoff quantities for the items 
in the estimate. 

Using Digitizer 

As you digitize or trace shapes on the blueprint, Digitizer draws 
the image, measures the shape in the scale you’ve set up, and 
displays the result on your screen. This is particularly useful for 
obtaining the dimensions of formula variables during takeoff. 
And if the variable has a preset digitizer mode (see page 35), 
Digitizer automatically starts in that mode (Area, Single Line, 
Continuous Line, or Count). 

Right-click a variable field to 
open a shortcut menu with 
the Digitizer command.

Click here 
to start the Digitizer.



You can send a single total to Estimating right away or accumulate several measurements 
and send them as a single dimension. 

When you finish 
digitizing the 
dimension, click 
here ...

... to bring the 
total into the 
selected field in 
Estimating.
Some basic concepts 9
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The ABCs of digitizing
Now that you understand the basics of Digitizer, you are ready to start digitizing. This 
section includes an overview of the steps required to complete some of the tasks you 
perform most often. 

■ Using the Help system 
■ Locating the tablet menu
■ Selecting part of the plan to work on (Zoom Window command)
■ Setting the drawing scale
■ Counting
■ Digitizing single lines
■ Digitizing continuous lines
■ Digitizing areas
■ Printing the image
The ABCs of digitizing 11



Using the Help system
No matter where you 
are in Digitizer, there is 
help available. How you 
get to the information is 
entirely up to you. One 
way is to go directly to 
the appropriate help 
topic from a field or 
window. Another way is 
to look for topics using 
the Contents, Index, 
and Find tabs in the 
Help window.

Keep in mind that the 
Help system contains 
all of the information in 
this book and much 
more. Step-by-step help 
topics and “Show Me” 
demos are available to 
guide you through 
many of the procedures 
covered in this section.
12 Getting Started
Get help about a field or window

You can get information about the commands, buttons, fields, 
options, or windows in Digitizer with a single keystroke or click 
of the mouse. 

For information 
about the window, 
click here.

For information 
about a field or 
option, click here,
then click the field.



This tab is 
a book. Cli
the list take
that topic o
of relevant

This tab 
lists the 
primary 
topics.
Learn how to complete tasks with procedural topics

The Help system also includes step-by-step instructions for most tasks and procedures. It 
is always a good idea to check the "Related topics" at the bottom of a help topic for jumps 
to these procedural topics. 

Find information

In the Help system, you can find information by looking in the table of contents and index 
and searching for specific word. 

like the index to 
cking a word in 
s you directly to 
r displays a list 
 topics.

If you can’t find what you need 
in the Contents or Index, 
you can search for any word 
or combination of words.
The ABCs of digitizing 13



Locating the tablet menu
The tablet menu gives 
access to most of the 
features on the menus 
and toolbar in Digitizer. 
Using the tablet menu is 
optional, but it can 
eliminate the need to 
move back and forth 
between the digitizer 
and the keyboard.

The Locate Tablet 
Menu function tells 
Digitizer where the tab-
let menu is located on 
the digitizer, thus per-
forming the necessary 
setup for the tablet 
menu to work.

This option is available 
only if:
■ Your digitizer is 

hooked up.
■ You’ve checked the 

Enable tablet menu 
box in the Options 
window.

■ Digitizer can find the 
PDWmenu.dat file.
14 Getting Started
Position the tablet menu

Place the tablet menu within the active area on your digitizer. We 
recommend you tape the edges to securely fasten the tablet 
menu to the digitizer.

Choose the Locate Tablet Menu command 

You can find this command on the Tools menu. 

To locate the tablet menu, 
click here.



Digitize the points on the tablet menu

When you select the Locate Tablet Menu command, your cursor changes to a crossbar 
and the first prompt displays in the status bar.

2. Digitize this point second.

1. Digitize this point first.
The ABCs of digitizing 15



Selecting part of the plan to work on
Before you begin doing 
takeoff with the Digi-
tizer, you might want to 
select part of the plan to 
focus on. You can use 
the Zoom Window com-
mand to identify the 
portion of the plan 
where you want to work. 
“Zooming in” on the 
plan makes it easier to:

■ Digitize large 
drawings.

■ See details of the 
digitized image in the 
graphics area.
16 Getting Started
Choose the Zoom Window command

You can find this command on the View menu and the toolbar. 

Digitize the upper left corner 

Digitize the upper left corner of the area where you want to work 
and drag your pointing device (mouse, stylus, or digitizer puck) 
down and to the right. 

A zoom rectangle appears to help you define the boundaries of 
the section where you want to work. 

To define a 
work area, click 
here or here.

Upper left corner

Zoom rectangle



Digitize the lower right corner 

When you reach the lower right corner of the section you want to work on, click again. 

After you finish digitizing one part of 
a large drawing,

click here to select another area,

or click here to reset the graphic area 
to include the entire digitizer tablet.

Lower right corner

Zoom rectangle
The ABCs of digitizing 17



Setting the drawing scale
There are two ways to 
set the drawing scale:

■ Known scale – use 
this procedure when 
the scale is provided 
for you and you are 
confident that it’s 
correct.

■ Autoscale – use this 
procedure if the 
drawing is not to 
scale or the scale is 
not provided for you.

You can see the current 
drawing scale in the 
right corner of the 
Status bar.
18 Getting Started
Open the Scale window

You can find the Scales command on the Digitize menu, the 
toolbar, and the status bar. 

Enter a known scale

If you know the drawing scale and are confident it is correct, 
enter the horizontal and vertical scales in the Scale window. 

To open the 
Scales window,
click here, 
here,
or here.

Enter the horizontal and 
vertical scales in these fields.



Use automatic scaling

If you aren’t sure of the drawing scale, you can have Digitizer calculate the scale for you. 
To set the scale using a given line, you simply click the Autoscale button and digitize that 
line. 

Click here.

Click the appropriate option to indicate 
whether the horizontal and vertical scales 
are the same or different.

Click OK to have Digitizer calculate 
the scale automatically.

Digitize the first and last points ...

... and enter the length of the line.
The ABCs of digitizing 19



Counting
Count mode tells you 
how many points have 
been entered with the 
digitizer. In addition, 
you have the ability to:

■ Choose the count 
symbol that appears 
on the screen either 
before you start or 
while you are count-
ing. 

■ See the previous and 
current dimensions by 
clicking the totals bar.

■ Set up a count scale 
which is used as a 
multiplier for each 
point you digitize.
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Start Count mode

You can find the Count command on the Digitize menu and the 
toolbar. 

Digitize the points

As you digitize, the number of points displays in the totals bar. 
The current total can be added to or subtracted from the grand 
total. The Undo button allows you to remove count points one at 
a time. 

To start this mode, 
click here or here.

To select a count 
symbol, click here.

Add
Subtract

Grand total
Current total

Undo

Count scale



Send the value to Estimating

You can add several counts and send them as a single total. When you finish counting, 
clicking the Done button sends the total to the selected field or cell in Estimating. 

Click here 
to send the total from 
Digitizer ...

... to Estimating.
The ABCs of digitizing 21



Digitizing single lines
Single Line mode cal-
culates the straight-line 
distance between two 
digitized points. For 
example, you might use 
this mode to measure 
joist or rafter lengths. 
At any time you can:

■ Define the line style 
and color that 
appears on your 
screen. 

■ See the last and cur-
rent dimensions by 
clicking the totals bar.

As mentioned before, 
the toolbar includes 
buttons that allow you 
to add or subtract the 
current total to the 
grand total. The Undo 
button removes the last 
line digitized.
22 Getting Started
Start the Single Line mode

You can find the Single Line command on the Digitize menu and 
the toolbar. 

Digitize the beginning and end of the line

For each line, digitize the two ends. Digitizer calculates the 
length which then appears as the current total in the totals bar. 
Digitizing a third point starts a new line and adds the current 
total to the grand total. 

To start this mode, 
click here or here.

To define the line style 
and color, click here.

The length 
appears here.

Digitize the beginning and 
end of the line.



Send the value to Estimating

When you finish digitizing single lines, click Done to send the total to Estimating. 

Click here 
to send the total from 
Digitizer ...

... to Estimating.
The ABCs of digitizing 23



Digitizing continuous lines
Continuous Line mode 
calculates the length of 
a continuous line. For 
example, you might use 
this mode to measure 
the perimeter of a regu-
lar or irregular-shaped 
slab.

Again, you can:

■ Define the line style 
and color. 

■ See the last and cur-
rent dimensions.

■ Add or subtract the 
current total to the 
grand total. 

■ Undo the entire line a 
point at a time.
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Start the Continuous Line mode

You can find the Continuous Line command on the Digitize 
menu and the toolbar. 

Digitize continuous lines

To measure a straight line, you simply digitize its end points. If 
the line is curved, press down on the pointing device as you 
trace. Digitizer shows the cumulative length in the totals bar as 
you move along the line. 

To start this mode, 
click here or here.

To define the line style 
and color, click here.

Digitize the four 
straight lines by 
clicking points 1-5...

... and trace the 
curved line.

1

2 3
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Send the value to Estimating

When you finish digitizing continuous lines, click Done to send the total to Estimating.

Click here 
to send the total from 
Digitizer ...

... to Estimating.
The ABCs of digitizing 25



Digitizing areas
Area mode calculates 
the area of a closed 
shape. For example, 
you might use this mode 
to measure the surface 
area and perimeter of a 
regular or irregular- 
shaped slab.

As in the other modes, 
you can:

■ Define the line style 
and color. 

■ See the last and cur-
rent dimensions.

■ Add or subtract the 
current total to the 
grand total. 

■ Undo the last point 
digitized.

When you digitize 
areas, Digitizer also cal-
culates the perimeter. 
You can transfer the 
value of that perimeter 
to an estimate using the 
Recall Perimeter com-
mand in Estimating.
26 Getting Started
Start the Area mode

You can find the Area command on the Digitize menu and the 
toolbar. 

Digitize areas

Digitizing an area involves tracing or digitizing the outline of a 
shape much like the Continuous Line mode. But in Area mode, 
Digitizer automatically closes the shape by connecting the last 
point digitized to the first point while continuously calculating 
the enclosed area. When the shape is complete, click the Add or 
Done button. 

To start this mode, 
click here or here.

To define the line 
style and color, 
click here.

First point Last point

Connecting line drawn 
by Digitizer

1

2 3

4
5

6



If you want to exclude part of an area from the total, simply digitize the second area and 
use the Subtract button. 

Send the value to Estimating

When you finish digitizing areas, click Done to send the total to Estimating. 

Digitize a 
second area ...

... and click here to 
subtract it from the total.

When you click Done, the 
total goes into the estimate.
The ABCs of digitizing 27



Printing the image
After you have digitized 
an image, you can print 
it. You also have the 
option of including a 
project name and refer-
ence information in the 
title block.

The project name and 
reference are stored for 
the current digitizing 
session only. When you 
exit Digitizer and Esti-
mating, the project 
name and reference 
information are 
cleared.

The printed image is 
‘scaled’ to make best 
use of the paper size of 
your printer (either por-
trait or landscape). The 
scale on the printed 
image will not match 
your plan scale, but is 
correct for the printout.
28 Getting Started
Digitize the image

Digitize the image and turn off the digitizing mode. To turn off 
the digitizing mode and remain in Digitizer, select the cancel 
button:

 Cancel

Page Setup

To display the Page setup window, select the Page setup 
command on the File menu. Enter the project name and 
reference information you want to print in the title block on the 
printed image. 

Then click OK.

Enter the project 
name and reference 
information here.

Click here.



Print

You can find the Print command on the File menu and the toolbar. If you have set up a 
project name and reference information, the title block that prints with the image looks 
similar to the one shown below. 

Timberline Digitizer

Project name: McKenzie Oaks 2
Reference: Landscaping

Date: Thursday, April 26, 2001 3:57 PM

To print,
click here or here.

Sample Title Block
The ABCs of digitizing 29
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Time-saving tips
This section includes tips to help you work more efficiently. In addition, you’ll find these 
and many other hints throughout the Help system.

If you want to learn more about working with Windows, choose Help on the Start menu.
Time-saving tips 31



Making the most of Digitizer
Digitizer provides many 
convenient features to 
help you work effi-
ciently. In addition to 
the standard Windows 
techniques, there are 
others which may not be 
obvious at first glance. 
32 Getting Started
Shortcut menus

Shortcut menus are special menus that open when you click in a 
window with the right mouse button (or the designated button on 
the pointing device). Shortcut menus provide quick access to 
commands related to your current task. 

■ In Digitizer, most of the toolbar and menu commands are 
available on the shortcut menu.

■ In Estimating, the Digitizer and Recall Perimeter commands 
are available on the shortcut menu.

Status bar

The status bar is located at the bottom of the Digitizer window; 
helpful messages and instructions appear here. You can also see 
the current drawing and count scales. A quick way to open the 
Scales window is to click on the Scale or Count scale field.

Totals bar

The totals bar is located directly above the status bar. This is 
where Digitizer displays the current total(s) and grand total for 
the session. Click the totals bar to open the Current Totals 
window. 

This area shows the 
appropriate dimensions 
from the previous session.

This area shows the 
appropriate dimensions 
for the current session.



Placing the toolbar conveniently

Initially, the toolbar is positioned below the graphics area. To make digitizing more 
efficient, you can move the toolbar around or even change its size and shape. 

With the pointer on the background of the toolbar, simply drag it anywhere in the digitizer 
window. 

■ If you drop the toolbar in the graphics area, you can change its shape and size by 
dragging one of its borders.

■ If you drop the toolbar on the window frame, it becomes attached to the frame.

Saving an image

Digitizer provides a way for you to document the dimensions you digitize. The Save 
As/Export command on the File menu saves the image in the Digitizer window as a file 
which can be imported by other applications. There are options for saving the image in a 
.bmp (bitmap), .emf (enhanced metafile), .jpg (JPEG), or .tif (TIFF) format. You can also 
edit a saved image in programs such as Paint. 

Count
Single Line

Continuous Line
Area

Add
Subtract

Zoom Window
Zoom Extents

Undo
Clear
Close

Print
Clear Total

Save Dimension
Help

Done

Define Line/Count Symbol

Scale
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What to do if you make a mistake

Digitizer provides several ways for you to redo one or more digitized entities. 

Undo 

Use Undo to reverse your previous action. This button deletes the last entity that was 
digitized. Each click deletes one more digitized point until the current total reaches 
zero. In Single Line mode, Undo deletes only the last line digitized.

Clear 

Use Clear when you want to redo a digitized object. This button clears the graphics and 
totals, but leaves you in the selected digitizing mode. Clear is also available on the 
shortcut menu.

Cancel 

Use Cancel to start over or turn off a digitizing mode. This button deletes the image and 
both totals. After that, you can choose a different digitizing mode or close the digitizing 
session.

Clear Graphic

Use the Clear Graphic command when you want to delete the image from the graphics 
area without clearing the values in the totals bar.

To use this command, select Clear Graphic from the shortcut menu. Clear Graphic is 
also available on the Edit menu. 

Clear Total 

Use Clear Total when you want to reset the total to zero without losing the digitized 
image. This allows you to work with several images at the same time. Clear Total is also 
available on the Edit menu.
ed



Digitizing from Estimating
Digitizer works hand in hand with Timberline Estimating products to make your job 
easier. You can start Digitizer from any takeoff quantity cell or variable field in 
Estimating. 

Setting the digitizing mode in advance

A most convenient feature is the ability to assign a digitizing mode to the variables used 
by formulas in Estimating. Then whenever you start Digitizer from such a variable, it 
automatically starts up in the appropriate mode. 

Look for this button on the 
Estimating toolbar.

Or right-click a takeoff quantity or variable and 
choose the command from the shortcut menu.

In the Variable window, click 
here and click a digitizer mode.

In the Formula window, 
highlight a variable and 
click here.
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Go ahead … try it out
Now that you’ve installed the software and been through this booklet, go ahead—and try 
digitizing some dimensions. It’s so easy that you can just start right in. It won’t be long 
before you’ll feel like an old pro. 

For assistance beyond this booklet, our comprehensive Help system is always close at 
hand.

■ While working with Digitizer, you can quickly get context-sensitive help with the [?] 
button or F1 key. 

■ If you want additional guidance, check out the information in the Help system. 

And in conclusion 

We think you’ll find Digitizer a useful tool. Thanks for taking the time to read this booklet 
and for becoming one of our valued users.
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